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6 Introduction 

Introduction 

CDL3 - Club Dash Logger 
The CDL3 is a sophisticated display and powerful control device combined in 
one lightweight unit. With the addition of a Data Logging upgrade it becomes 
a fully programmable data logger with 8 MB memory (see Dash Logger 
Upgrades). The screen layout is fully configurable to display a multitude of 
data channels, warning alarms, lap times, fuel calculations, minimum corner 
speeds, maximum straight speeds and more. The CDL3 performs 
calculations, acquiring data from other devices such as an ECU, another 
Dash Logger and input expander modules, which enable it to log a multitude 
of inputs. 

Features 
All MoTeC Dash Loggers come with a range of features as standard and 
several options available as upgrades to customise and grow the system. 
These additional features are activated through a simple password system, 
and can be purchased at any time when you need them.  
See Dash Logger Upgrades 

General 
• All-in-one display, logger and controller eliminates the need for separate 

devices 
• Suitable for bikes, cars, marine and industrial applications 
• Compact, durable and reliable unit 
• Supports Wideband Lambda from MoTeC PLMs or LTCs, using Bosch 

LSU or NTK UEGO 5 wire sensors 
• Straightforward control for lights, fans, pumps (optional) 
• Easily integrated with MoTeC CAN based devices, e.g. Power Distribution 

Modules, expanders, GPS, shift lights and ECUs 

Logging and Analysis  
• Optional internal data logging of 8 MB  
• Fast download via Ethernet 
• Data analysis with i2 Standard 
• Accommodates over 300 channels derived from a mixture of analogue 

and digital inputs, RS232 and CAN data channels 



MoTeC  Introduction 7 

• Configurable to use sensors from some existing engine management 
systems 

Display 
• Customisable screen layout, measurement units and warnings 
• Configurable curved bar graph can display any channel with optional 

peak, hold and shift markers 
• 48 user-defined alarms, e.g. Low Oil Pressure, Low Fuel, Fast Lap 
• Programmable overrides - particularly useful for showing values such as 

lap times 
• Three programmable 'pages' for Warm-up, Practice and Race ensure the 

driver is shown only the most relevant information at any given time 
• Adjustable backlight  

Software 
• Windows-based software designed for setup and management of the 

display and data logging system 
• The user can generate a configuration file offline and send the completed 

configuration to the Dash Logger 
• Calculations including lap times, lap gain/loss, speed and distance, fuel 

prediction 
• Monitor active channels—view all channels live 
• Sensor zeroing 
• Details editor including event, venue and vehicle details 
• Extensive Help screens 
• To access the newest software features you can download the latest 

version from www.motec.com/downloads 
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Compatibility 
• MoTeC ECUs: M4, M48, M8, M84, M400, M600, M800 and M880 
• MoTeC Accessories: E888, SLM, PLM, LTC, BR2, PDM, GPS, PDM, etc. 
• Many non-MoTeC ECUs and other devices 

Required Accessories 
Refer to Connecting the Dash Logger to a PC 
• Standard Ethernet cable 

Optional Accessories 
• Any one of the following: 

o #18023 Track Display Kit 
o #18024 Track Logging Kit 
o #62203 Loom, CDL3 Terminated 
o #61196 CDL3 Input Loom 
o #61197 Loom, CDL3 to OBD-II 
o #61198 Loom, CDL3 to MoTeC CAN ECU 
o #61199 Loom, CDL3 to RS232 ECU 
o #61224 Cable network RJ45 

 

System Overview 
The Dash Logger offers extensive possibilities to integrate with ECUs, 
peripheral devices and accessories to form a complete solution that powers, 
controls, logs, monitors and communicates virtually any automotive 
parameter. 

Typical devices used with the Dash Logger 

ECUs 
The CDL3 Dash Logger can be connected to all MoTeC engine management 
systems and some other manufacturers' ECUs either via CAN, RS232 or 
OBD-II. This avoids duplication of sensors and allows the Dash Logger to 
display and log many ECU parameters. 
The typical update rate is about 20 times per second for RS232 and 50 times 
per second for CAN, but is less from OBD-II. 
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Sensors 
The optional Dash Logger inputs* can be connected to a wide variety of 
sensors. Different types of sensors are available to suit different types of 
measurements, for example: temperature, pressure, movement etc. 
Sensors convert a physical measurement (e.g. pressure) into an electrical 
signal (e.g. volts). 
Different types of sensors generate different types of electrical signals. For 
example, most temperature sensors convert the temperature into a variable 
resistance which may be measured by an Analogue Temperature input. 
However most wheel speed sensors generate a variable frequency signal 
which must be connected to either a Digital input or a Speed input. 
*To use these inputs, you will need to enable the #29500 CDL3 12 I/O 
upgrade. 

Expanders 

E888 
The CDL3 supports an E888 Expander, 8 thermocouples only.  

Accessories 

BR2 
A BR2 Beacon Receiver may be connected to the CDL3, which allows the 
Dash Logger to calculate lap times for display and to provide lap 
information for the data analysis software. 

SLM-C 
The SLM-C Club Shift Light Module can be used for shift lights, warning 
lights and other driver alerts. 
The SLM-C includes 8 coloured LEDs that can be programmed to display 
in a pre-defined pattern. 

GPS 
The CDL3 Dash Logger supports many GPS (Global Positioning System) 
devices allowing it to record speed and position information as well as 
providing lap timing. 
This information can be used in the i2 data analysis software to create 
track maps, and plot and compare driven lines. 
A 10 Hz GPS is supplied as part of the CDL3 Track Kits. 
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Video 
MoTeC’s Video Capture System (VCS) is an integrated in-car camera 
system, recording video and audio using the MPEG-2 video compression 
format at broadcast quality. It includes a built in real-time graphics 
processor that allows sensor data to be overlaid onto the video in real-time 
without the need for additional hardware. The CAN interface enables 
communication with other devices, for example to set Auto Start/Stop 
Recording conditions and synchronisation.  
Multiple video streams, from in-car cameras for example, can be linked 
with logged data for synchronised playback of footage alongside other 
analysis components.  
Note: Synchronisation can be completed manually or automated by using 
the CAN Video Sync feature. 

Lambda Measurement 

PLM 
The PLM Professional Lambda Meter measures the air fuel ratio over a 
wide range of mixtures with fast response time. It is compatible with Bosch 
LSU and NTK UEGO Lambda sensors and displays the Lambda readings 
via the integrated display. 

LTC/LTCD/LTC NTK 
LTC Lambda to CAN modules provide accurate Lambda measurements 
even when the exhaust gas temperature changes rapidly. They are 
compatible with the Bosch LSU 4.9 / NTK Lambda sensors and transmit 
Lambda readings via the CAN bus.     

Remote Displays 
A remote display device may be connected to the CDL3 to allow display of 
any value that the Dash Logger calculates, such as lap times and warning 
alarm messages. 
The Club Dash Logger supports MDD displays which are connected via CAN. 

PDMs 
Power Distribution Modules are designed to replace conventional relays, 
fuses and circuit breakers by providing electronically switched power to the 
various electrical systems in the vehicle. This simplifies wiring and switch 
requirements, while increasing reliability. 
Full diagnostic information, including output currents and error status, can be 
transmitted via CAN to the Dash Logger. 
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Several models are available to suit vehicles with different complexity ranging 
from 15 to 32 outputs and 12 to 23 inputs. 

Other Devices 
Many other devices can be connected to the CDL3 Dash Logger.
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CDL3 Track Kits 

CDL3 Track Display Kit 
The CDL3 Track Display Kit is a complete plug and play solution. All wires are 
labelled and terminated, ensuring a fast, easy installation. 
The Track Display Kit will allow you to perform the following functions and 
more with your CDL3: 

• Lap timing 
• Shift lights 
• Warnings 
• Multiple page layouts 
• ECU connection 
• Display of sensor values 

 
Kit contents: 
1 X 18022 CDL3 Club Dash 
1 X 62203 Loom, CDL3 Terminated 
1 X 61221 Loom, Two Button 
1 X 41304 10 Hz GPS L10 
1 X 18122 SLM-C Club Shift Light Module 
1 x 61224 Ethernet Communications Cable 
 

CDL3 Track Logging Kit 
The Track Logging Kit is a complete plug and play solution with data logging. 
All wires are labelled and terminated, ensuring a fast, easy installation. 
The Track Logging Kit will allow you to perform the following functions and 
more with your CDL3: 

• Lap timing 
• Track Mapping 
• Data Logging 
• Shift lights 
• Warnings 
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• Multiple page layouts 
• ECU connection 
• Display of sensor values 
• Driver analysis 
• Engine performance measurement 
• Data analysis using MoTeC’s i2 software 

 
Kit contents: 
1 X 18022 CDL3 Club Dash Logger 
1 X 29518 CDL3 Logging upgrade(8M) 
1 X 62203 Loom, CDL3 Terminated 
1 X 61221 Loom, Two Button 
1 X 41304 10 Hz GPS L10 
1 X 18122 SLM-C Club Shift Light Module 
1 x 61224 Ethernet Communications Cable 

Installing the CDL3 Terminated Loom 
The CDL3 has an optional terminated loom that is pre-configured to get the 
most out of your Dash Logger. This loom plugs directly into the back of the 
CDL3, and has labelled wires for each of the parts that come with the Track 
Kit. The loom has these connections: 

• Power - Connect to a 12 - 32 V power source and ground with a 5 
ampere fuse. When using the CDL3 Track kits, use the cigarette 
lighter adapter. 

• GPS - Ensure that you connect a compatible 5 V GPS unit to the lead 
labelled “GPS” only. Plugging a GPS into the SLM lead will 
damage the GPS. 

• Buttons - Plug in the button loom as supplied with the kit for Mode, 
Alarm Acknowledge and Next Line functionality.  

• SLM/SLM-C - Connect your Shift Light Module to this lead only. 
• ECU - ECU communications are sent to the CDL3 via this connector. 

Terminated looms are available for OBD-II, M84, MoTeC ‘Hundred 
Series’ ECUs and RS232 (M4, M48 and other brands). 

• Ethernet - For communications between your Dash and a PC for 
configuration. 
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Installing the CDL3 Input Loom  
The CDL3 Input loom is a fast way to add sensors to your CDL3 when you 
have added the I/O upgrade. Following these instructions, you can quickly 
add wiring for 4 AVs and 2 ATs to your vehicle’s loom. 
 
Installation Process 
1. Connect DTM 4 pin male of the Input loom to GPS DTM 4 pin female 

connector of the main loom. 
2. Connect DTM 4 pin female connector of the Input loom to the GPS 

connector. The purpose of this connection is to supply 5 V and 0 V to the 
sensors. 

3. Remove the main 34 pin CDL3 connector from the back of the CDL3. 
4. Unlock the CDL3 connector by pushing in the long white locking tab. 
5. Remove white plugs from pins 3, 4, 5, 6, 16, 17. 
6. Insert pinned wires into the CDL3 connector as follows: 

• AV1 – blue wire into pin location 3 

• AV2 – green wire into pin location 4 

• AV3 – purple wire into pin location 5 

• AV4 – grey wire into pin location 6 

• AT1 – brown wire into pin location 16 

• AT2 – orange wire into pin location 17 

7. Secure the pins in place by pushing in the two locking tabs on the CDL3 
connector. If the two locking tabs are difficult to push back, this indicates 
that one of the inserted pins is not seated correctly. 

8. Run the AV and AT wires to the locations required for your new sensors. 

Notes: 
• The red wires are 5 V 
• The black wires are 0 V 
• Coloured wires are the AV and AT wires 
• You can shorten the looms as required by cutting them shorter 
• You should loop and tie up unused looms for future use 
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Installing the CDL3 to OBD-II loom 
The OBD-II loom is a terminated adapter that joins the CDL3 terminated loom 
(#62203) to the standard on-board diagnostics port on most road cars 2007 or 
later. 
There is no standard location for the OBD-II socket in a road car, so you will 
have to search your vehicle to find its location. The most common place is in 
the driver’s foot well, under the dash panel. In some instances it is directly 
accessible, other times you may need to remove a covering panel. 
  

Installation method – if CDL3 came pre-configured 
1. Plug in the CDL3, SLM-C, buttons and GPS. DO NOT connect the CDL3 

to OBD-II loom at this stage. 
2. Plug the cigarette lighter power adapter into a spare power supply socket. 
3. Press and hold the red button on the button loom for at least 5 seconds. If 

correctly configured, “OBD-II” will display on the CDL3. NOTE: If “OBD-II” 
does not display, do not plug in the CDL3 to OBD-II loom and follow the 
NOT pre-configured instructions. 

4. Plug the 4 pin DTMF connector into the connector labelled ECU. 
5. Find the OBD-II connector and plug in the mating connector. 
6. Start the car. Installation should now be complete. 
  

Installation method – if CDL3 is NOT pre-configured 
1. Plug in the CDL3, SLM-C, buttons and GPS. DO NOT connect the CDL3 

to OBD-II loom at this stage. 
2. Plug the cigarette lighter power adapter into a spare power supply socket 
3. Connect a laptop to the CDL3 using the provided Ethernet lead 
4. Start up CDL3 Dash Manager 
5. Select Tools > Connection settings in CDL3 Dash Manager, then select 

Add 
6. Select the Search button 
7. Highlight the device displayed in the connected device window, and select 

the Select button 
8. Select OK on the new IP screen 
9. Select OK on the Connection settings screen 
10. Select File > New 
11. Select CDL3 OBD2 configuration 



16 CDL3 Track Kits 

12. Select Online > Send Configuration to put the OBD-II configuration in 
the Dash 

13. Save the file with a new name, such as “my start file” 
14. Choose Yes, or Ok to any warnings that display while this new 

configuration is sent to the Dash. 
15. Press and hold the red button on the button loom for at least 5 seconds. If 

correctly configured, “OBD-II” will display on the CDL3. NOTE: If “OBD-II” 
does not display, do not plug in the CDL3 to OBD-II loom and contact your 
dealer. 

16. Plug the 4 pin DTMF connector into the connector labelled ECU. 
17. Find the OBD-II connector and plug in the mating connector. 
18. Start the car. Installation should now be complete. 

Installing the CDL3 to CAN ECU loom 
The CDL3 to CAN ECU loom connects the CDL3 loom to a MoTeC CAN ECU 
via the CAN communications connector. 
NOTE: The CAN communications connector is the socket that you would 
normally use to connect a UTC to your ECU for tuning. 
 

Installation method – if CDL3 came pre-configured 
1. Plug in the CDL3, SLM-C, buttons and GPS.  
2. Connect the CDL3 to CAN ECU adapter loom to the ECU plug on your 

CDL3 loom. Plug the other end into your ECU communications connector. 
3. Plug the cigarette lighter power adapter into a spare power supply socket. If 

your vehicle does not have a power supply socket, cut off the adapter and 
connect the red wire to a fused 12 V source and the black wire to chassis 
ground. 

4. Power up the car, including turning on the MoTeC ECU. The number in the 
top right of the display should change to show the current Engine 
Temperature. NOTE: If the Engine Temperature is not displayed, then 
either your ECU or CDL3 isn’t correctly configured. Follow the not pre-
configured instructions. 

5. The installation should now be complete. 
  

Installation method – if CDL3 is NOT pre-configured 
1. Plug in the CDL3, SLM-C, buttons and GPS.  
2. Connect the CDL3 to CAN ECU adapter loom to the ECU plug on your 
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CDL3 loom. Plug the other end into your ECU communications connector. 

3. Plug the cigarette lighter power adapter into a spare power supply socket. If 
your vehicle does not have a power supply socket, cut off the adapter and 
connect the red wire to a fused 12 V source and the black wire to chassis 
ground. 

4. Connect a laptop to the CDL3 using the Ethernet lead provided. 
5. Start up CDL3 Dash Manager. 
6. Select Tools > Connection settings in CDL3 Dash Manager, then select 

Add. 
7. Select the Search button. 
8. Highlight the device displayed in the connected device window, and select 

the Select button. 
9. Select OK on the new IP screen. 
10. Select OK on the Connection settings screen. 
11. Select File > New 
12. Select CDL3 M400 M600 M800 template if you have one of those ECUs, 

or select the CDL3 M84 template. 
13. Select Online > Send Configuration to put the configuration in the Dash 
14. Save the file with a new name, such as “my start file” 
15. Choose yes or ok to any warnings that display while this new 

configuration is sent to the Dash. 
16. Power up the car, including turning on the MoTeC ECU. The number in 

the top right of the display should change to show the current Engine 
Temperature. NOTE: If the Engine Temperature is still not displayed, see 
ECU Settings. 

17. The installation should now be complete. 
 
ECU settings 
Start ECU manager, and connect your UTC. 
Select Adjust > General setup > Communications > CAN Setup 
Set CAN 0 Data to 0 
Set CAN 0 Address to 1520 
Set CAN 0 Transfer Rate to 50  
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Installing the CDL3 to RS232 ECU loom 
The CDL3 to RS232 ECU loom connects the CDL3 loom to an ECU via its 
RS232 communications connector. 
NOTE: The RS232 communications connector is the socket that you would 
normally use to connect to your ECU for tuning. 
 

Installation method – if CDL3 came pre-configured 
1. Plug in the CDL3, SLM-C, buttons and GPS.  
2. Connect the CDL3 to RS232 ECU adapter loom to the ECU plug on your 

CDL3 loom. Plug the other end into your ECU communications connector. 
An additional cable/adapter may be required in conjunction with the RS232 
adapter for some ECU’s. 

3. Plug the cigarette lighter power adapter into a spare power supply socket. If 
your vehicle does not have a power supply socket, cut off the adapter and 
connect the red wire to a fused 12 V source and the black wire to chassis 
ground. 

4. Power up the car, including turning on the ECU. The number in the top right 
of the display should change to show the current Engine Temperature. 
NOTE: If the Engine Temperature is not displayed, then either your ECU or 
CDL3 isn't correctly configured. Follow the not pre-configured instructions. 

5. The installation should now be complete. 
  

Installation method – if CDL3 is NOT pre-configured 
1. Plug in the CDL3, SLM-C, buttons and GPS.  
2. Connect the CDL3 to RS232 ECU adapter loom to the ECU plug on your 

CDL3 loom. Plug the other end into your ECU communications connector. 
An additional cable/adapter may be required in conjunction with the RS232 
adapter for some ECU’s. 

3. Plug the cigarette lighter power adapter into a spare power supply socket. If 
your vehicle does not have a power supply socket, cut off the adapter and 
connect the red wire to a fused 12 V source and the black wire to chassis 
ground. 

4. Connect a laptop to the CDL3 using the Ethernet lead provided. 
5. Start up CDL3 Dash Manager. 
6. Select Tools > Connection settings in CDL3 Dash Manager, then select 

Add. 
7. Select the Search button. 
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8. Highlight the device displayed in the connected device window, and select 

the Select button. 
9. Select OK on the new IP screen. 
10. Select OK on the Connection settings screen. 
11. Select File > New 
12. Select CDL3 M4 M48 template if you have one of those ECUs. Other 

ECUs will require a custom template. 
13. Select Online > Send Configuration to put the configuration in the Dash. 
14. Save the file with a new name, such as “my start file” 
15. Choose yes or ok to any warnings that display while this new 

configuration is sent to the Dash. 
16. Power up the car, including turning on the ECU. The number in the top 

right of the display should change to show the current Engine Temperature. 
NOTE: If the Engine Temperature is still not displayed, see ECU Settings. 

17. The installation should now be complete. 

ECU settings 
Start M4/M48/M8 ECU Manager and connect the laptop. 
Select Adjust > General setup > Miscellaneous Setup 2 
Set Telemetry Baud Rate to 19201 
Set Telemetry Data Set to 5 
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Installation 
This section provides information on how to install the Dash Logger in the 
vehicle and connect it to other devices. It will also provide information on how 
to install the software.  

Mounting and Wiring 
The Dash Logger has three threaded mounting posts. For further details see 
Mounting Dimensions 

Mounting Tips 
• Avoid twisting the case: use washers between the unit and the mounting 

panel to ensure that the unit is mounted only at the mounting points and 
do not over tighten the mounting screws. 

• Vibration isolation may be desirable if the vehicle vibrates severely. 
• Mount so that the connector may be easily accessed. 
• Orientation: for best contrast, the display should be viewed at an angle of 

approximately 20 degrees, however the Dash Logger will provide good 
contrast between 0 and 40 degrees. Display reflections should also be 
considered when determining the mounting angle. 
 

 
  
The CDL3 uses a 34 pin connector. See Connector and CDL3 Pin List By 
Function for full details.  

Wiring Tips 
• To ensure that the connector is sealed, plug unused holes with filler plugs.  
• Use 22# Tefzel wire (Mil Spec M22759/16-22) (5 A max at 100 �C) 
• Tefzel wire is difficult to strip unless the correct stripping tool is used. 
• Be careful not to nick the wires as this may result in wire failure or poor 

crimping. 



MoTeC  Installation 21 

• Some sensor connectors may not be available with 22# terminals, in 
which case doubling the wire over gives the equivalent of an 18# wire. 
This is suitable for many of the common sensor terminals. 

• Use the correct crimping tool for all contacts to ensure a reliable 
connection. 

• Power the Dash Logger via a separate switch and a 5 ampere fuse, to 
ensure the PC can communicate with the Dash Logger without the need 
to power the rest of the vehicle. 

• The CDL3 ground must have a direct connection to the vehicle battery. 
• The Dash Logger is connected to other devices via the CAN bus.  

Connecting Devices 
Peripheral devices can be directly connected to the Dash Logger's input and 
output pins. The Dash Logger can also send or receive data from other 
devices via either RS232 or CAN communications.    

Inputs – Requires I/O Upgrade 

Input Types 
A range of sensors is available to suit different types of measurement, e.g. 
temperatures, pressures, speed. Each type of measurement generates a 
different electrical signal that requires a suitable input type. 
Each sensor needs to be connected to the type of input designed to suit that 
type of sensor. 

MoTeC devices have the following input types available:   
• Analogue Voltage Inputs 
• Analogue Temperature Inputs 
• Digital Inputs 
• Wheel Speed Inputs 
 
In addition to sensors connected to the inputs, the Dash Logger has internal 
sensors available for battery voltage, device temperature and G-force. 

Analogue Voltage Inputs 
Analogue Voltage inputs are normally used to measure the signals from 
analogue voltage type sensors, i.e. sensors with variable voltage outputs, 
such as: 
o Rotary or linear potentiometers 
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o Signal conditioned three-wire pressure sensors 
o Thermocouple amplifiers 
o Accelerometers 
These inputs can also be used to measure two-wire variable resistance 
sensors if an external pull-up resistor is connected from the input to the 
5 V sensor supply. 
Additionally, on/off switch signals may be connected, which may also 
require an external pull-up resistor. 

Analogue Temp Inputs 
Analogue Temperature inputs are identical to Analogue Voltage inputs, 
except that they contain a 1000 ohm resistor which is connected internally 
from the input pin to the 5 V sensor supply. This allows the Analogue 
Temperature inputs to be used with two-wire variable resistance sensors, 
such as: 
o Two wire thermistor temperature sensors 
o Two wire variable resistance pressure sensors 
Some voltage output sensors can also be used if they can drive the 1000 
ohm resistor without causing an error in their reading (e.g. MoTeC 
Thermocouple Amplifier). 
Additionally, on/off switch signals may be connected. 

Digital Inputs 
Digital inputs can be used for the external switches required to operate the 
display. These inputs have a 4700 ohm resistor connected internally from 
the input pin to the 5 V sensor supply so that a switch can be simply 
connected between the input pin and 0 V. 
They can also be connected to a brake switch or other switch. 
Digital Inputs include the following measurement methods: 
o Frequency: The frequency of the input signal is measured 
o Period: The time between successive pulses is measured 
o Pulse width: The low time of the pulse is measured 
o Count: Counts the number of pulses 
o Phase Difference: Calculates the phase difference between two digital 

inputs 
o Beacon: For connection of a lap beacon 
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Speed Inputs 
Speed Inputs are identical to Digital Inputs except that they can also be 
configured to suit Variable Reluctance (Magnetic) sensors, such as some 
wheel speed sensors. Because the amplitude of the signal from these 
sensors changes with speed of rotation, variable trigger levels are 
required, which must vary with the frequency of the input signal. 
The Speed Inputs can also be used with Hall Effect type wheel speed 
sensors. 
The Pulse Width method measures the high time of the pulse rather than 
the low time as measured by the Digital Inputs. 

Input Specifications 
For full specifications refer to Input Characteristics  

Expanders 
If additional sensors are required, input expanders can be used, such as 
MoTeC’s E888. Sensors can be connected to the expander inputs and 
communicate via either RS232 or CAN. See Configuring Communications 

Outputs – Requires I/O Upgrade 
Auxiliary Outputs are used to control various vehicle functions, for example: 

o Gear Change Lights 
o Warning Lights 
o Relays controlling Thermatic Fans and Pumps etc. 

Note: Devices that consume more than the maximum current (e.g. motors) 
should be driven via a relay or a MoTeC PDM (Power Distribution Module). 

Output Specifications 
Full specifications can be found in Output Characteristics. 

Expanders 
If additional outputs are required, output expanders can be used, e.g. PDM. 
Expander outputs can perform the same tasks as the device outputs and can 
be driven by communication via either RS232 or CAN. See Configuring 
Communications. 

Communications 
Communications are used to send and receive data from one device to 
another. There are two communication protocols: RS232 and CAN. Generally 
older devices use RS232 and newer devices use CAN.  
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CAN (Controller Area Network) Communications 
This protocol enables communication between all devices connected to the 
same bus. The CAN bus allows for communicating at high speeds. The CDL3 
has two independent CAN communications ports that can be connected to 
other devices with a compatible CAN port. The bus speed for each interface 
can be set independently. 
Typical MoTeC devices communicating over CAN: 

o M84 and 'Hundred Series' ECUs: M400, M600, M800, M880 
o Shift Light Module: SLM, SLM-C 
o Lambda meters: LTCs, PLM 
o Expanders and input modules: E888, PDM 
o Displays: SDL3 
o Beacon receiver: BR2 

These devices communicate at 1 Mbit/sec, so any other devices connected 
on the CAN bus must also communicate at 1 Mbit/sec. If a device 
communicates at another speed, it should be wired to the other CAN bus, and 
the speed of that CAN bus must be set to match the speed of the device. 

RS232 Serial Communications 
This is a one to one protocol, communicating from one device to one other 
device. Typical devices communicating over RS232: 

o MoTeC M4, M48 ECUs 
o Radio telemetry device 
o Global positioning system: GPS 

Note: The Dash Logger can only communicate with devices for which it has 
the appropriate communications protocol defined. 
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Connecting Devices Examples 
Device  Connect via  Remarks  

Sensors Inputs: 
The appropriate input 
type depends on the 
sensor type 

MoTeC supplies datasheets 
with wiring details for all 
sensors via the website 

External Buttons for: 
- Display mode 
- Display next line 
(and optional 
previous line) 
- Alarm acknowledge
- Lap number reset 

Inputs: 
Digital or Speed inputs 

Wire between Dash Logger 
input and Dash Logger 0 V. 
If wired to an Analogue 
Voltage input, connect an 
external pull-up resistor 
between the input pin and 
the 5 V sensor supply. 

External LED Lights Outputs: 
Auxiliary output 

Wire between one of the 
Auxiliary Outputs and battery 
positive and include a 
current limiting resistor. 

SLM Shift Light 
Module 

Communications: 
CAN 

  

K-type 
Thermocouples 

Inputs: 
Analogue Voltage or 
Analogue Temperature 
input  
  

Connect via TCA (Thermo 
Couple Amplifier) 
 
 

Communications: 
CAN 

Connect via E888 

ECU M4, M48, M8 Communications: 
RS232 

Uses the Telemetry feature 
of the ECU to send data to 
the Dash Logger 

ECU M84, 'Hundred 
Series': M400, M600, 
M800, M880 

Communications: 
CAN 

Ensure the ECU and Dash 
Logger are connected on the 
same CAN bus 
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Software Installation 
This section provides information on Dash Manager software, and i2 Data 
Analysis software.  
It will also explain how to connect the Dash Logger to the PC.  

PC Recommendations 
MoTeC recommends a dedicated laptop for your race car with the following 
specifications: 
• Windows XP, Vista or Windows 7  
• Screen size: 1024 x 768  
• Processor speed: 1-2 GHz Pentium 
• 2 GB RAM 
• 256 MB graphics card 
• 2 USB ports 
• Ethernet port 
Most current laptops will meet the specifications above and this will ensure all 
MoTeC software will run on it. 

CDL3 Dash Manager Software 
CDL3 Dash Manager software is used for configuration, testing, retrieving the 
logged data, and for general management of the Club Dash Logger. 
CDL3 Dash Manager supports configuration of the following connected 
devices: E888, SLM, SLM-C. 

Installing Dash Manager Software 
1. Go to the MoTeC website at www.motec.com and navigate to 

software/latestreleases/CDL3 Dash Manager software 
OR  
Locate the Dash Manager software on the MoTeC Resource Disc 

2. Save the selected file in your preferred location (for example desktop) 
3. When downloading is finished, double click on the file and select run 
4. Follow the instructions on the InstallShield Wizard 
5. To start the program after installation, click the CDL3 Dash Manager 

icon on the desktop or click Start > All Programs > MoTeC > CDL3 
> CDL3 Dash Manager 
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Updating CDL3 Dash Manager Software 
Software updates are available free of charge, giving access to the latest 
features. Download the latest software version from the website and follow the 
software installation instructions to update to the new version. 
To update the associated firmware in the device, select Upgrade Dash 
Version from the Online menu. See Configuration Versions and Updating.    

i2 Data Analysis Software 
MoTeC's i2 data analysis software is used to analyse the logged data that has 
been recorded by the Dash Logger. Any number and combination of graphs, 
gauges and reports can be analysed simultaneously. The i2 environment can 
be customised to specific user requirements. 
i2 Standard is included with any Data Logging upgrade. 

Connecting the Dash Logger to a PC 
The Dash Logger connects to the Ethernet port on the PC. This requires a 
connector for the standard Ethernet cable in the loom. 
The CDL3 loom #62203 incorporates this connector. Alternatively the 
connector can be wired into an existing loom using the unterminated Ethernet 
cable (#61131). 
All options are used in conjunction with a standard Ethernet cable.  
Connection details are described in PC Connection 

PC Communications Setup 
To enable PC communications, a connection must be setup in the Dash 
Manager software to match the Dash Logger serial number.  

• On the Tools menu click Connection Settings and then click Add 
• Click OK to choose IP (Ethernet). This is the only available connection 

type. 
• Click Search* 
• In the list with discovered devices, click the required Dash Logger and 

click Select 
If the PC needs to communicate with more than one Dash Logger, repeat the 
steps. 

* The connection uses IPV6, which can be affected by firewall and anti 
virus applications.  
If you have a Dash Logger connected but it is not listed in Discovered 
Devices, try disabling or uninstalling all anti-virus software.  
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If the Device is 'discovered' without the anti-virus software, you can turn it 
back on and put in appropriate exceptions to allow the Dash Logger 
Manager to communicate with the device.   

Only one connection can be active at a time. To switch to a different Dash 
Logger, click Make Active. 
Tip: The current connection is listed at the bottom of the Dash Manager 
splash screen (this is the main Dash Manager screen with the picture of the 
Logger) 

For a quick way to switch between connections 
• In the Dash Manager splash screen, enter the connection number 

(to enter the splash screen, close all other windows in Dash Manager).  
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Configuration 
All aspects of the Dash Logger can be configured, including; which sensor is 
connected to which input, the calibration of each sensor, what to display and 
where to display it, what to log and how fast to log it, tacho range, warning 
alarms, multi stage shift lights etc. 
The configuration is stored in a file on the PC. When starting Dash Manager 
software, the menu items related to changing the configuration are 
unavailable. To make them available, load a configuration file either by 
opening an existing file or by creating a new one.   
All changes to the Dash Logger configuration are performed ‘Offline’, i.e. 
without the PC communicating with the Dash Logger. The changes are saved 
in the configuration file on the PC. The file must be sent to the Dash Logger 
before the changes take effect. See Sending and Retrieving Configuration 
Files. 
Tip: When using a laptop in and around a car, it is often not practical to use a 
mouse to navigate through the program. Using the keyboard to select options 
is easier. An overview is given in Windows Keyboard Shortcuts 

Configuration Sequence 
The configuration is best setup in the following order: 

1. Connections (Input Pins & Communications) 
2. Calculations (Lap Time, Fuel Prediction etc.) 
3. Functions (Logging, Display, Alarms, Auxiliary Outputs etc.) 

This simplifies the setup procedure by ensuring that the required channels are 
available for the functions that use them. 
Channels cannot be used until they have been generated by an input, 
calculation or function. 

Configuration File 
From the File menu the following options are available: 
• New – creates a new configuration based on a predefined template 
• Open – selects an existing file 

Right-click the configuration file to Rename, Delete, Send to a disk etc. 
• Save – saves a newly created  configuration with a meaningful name 
• Save as – can be used to create a copy of an existing configuration file by 

giving it a new name 
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• Edit Details – allows for entering event, venue and vehicle details to be 
stored with the configuration file 

• Check Channels – verifies that all channels are correctly generated  
• Edit Configuration Comments – allows for other comments to be stored 

with the configuration file 
• View Configuration Summary – gives a quick overview of the 

configuration file 
• Convert Logging Image – allows users to manually convert a log file for 

use in i2 
• Exit – exits the program 
  
Tip: The most recently used files appear at the bottom of the File menu. This 
is often the easiest way to open an existing file. 

Backups 
Whenever a file is saved, the previous content of the file is saved in the Save 
Backups directory. The total number of files is limited to 100. 

Channels 
Channels are used to convey information between the various systems of the 
Dash Logger.  

For example an input pin may feed a channel called ‘Fuel Pressure’. 
This channel may then be used by another system, such as the Display 
System or Data Logging systems. 

The Dash Logger channel scheme allows complete flexibility in channel 
usage, as any available channel can be used by any other function, i.e. any 
channel can be logged, displayed, used in conditions, used in alarms, used as 
an input to the user definable tables, etc. 
All systems within the Dash Logger that generate values must feed one of the 
channels. 

Pre-defined Channels 
MoTeC has defined an extensive list of channels. 

General Purpose Channels 
Since the use of all channels cannot be predetermined, a number of general 
purpose channels have been included for occasions when a suitable 
predefined channel is not available. 
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These general purpose channels may be required when measuring an 
uncommon value, or when a general purpose function needs to generate a 
special output channel. For example, a 3D table may generate an output 
channel to control a valve of some sort, in which case a general purpose 
channel may be used and named appropriately. 
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Channel Properties 
Each channel has defined properties, some of which may be modified by the 
user. Predefining these properties makes the channels easy to use 
throughout the rest of the software. 

• Properties that may be modified by the user 
o Name 

The channel names (and abbreviations) may be changed if necessary. 
However name changes should be limited to name preferences rather 
than redefining the purpose of the channel, except for the general 
purpose channels which may be renamed to suit the current use. 

o Abbreviation 
o Units (e.g. degrees Celsius, degrees Fahrenheit) 

The units for a channel can be selected from a predefined list, for 
example the Engine Temperature channel may have units of degrees 
Celsius, Fahrenheit or Kelvin. Conversion between units is 
automatically handled by the software. 
Note: The units are used for display purposes only. This means that 
the units can be changed at any time without affecting the calibration of 
the channel. 

• Fixed properties 
o Measurement type (e.g. Temperature) 

Defining the measurement type allows the channels to be displayed in 
any unit suitable for that type, with automatic conversion between the 
units. For example all temperature channels can be displayed in 
degrees Celsius, Fahrenheit or Kelvin. 

o Resolution 
The resolution of all channels is fixed, for example the resolution of the 
Engine Temperature channel is fixed at 0.1 °C. 
Fixed channel resolutions ensure that the unit conversion system 
works properly and that channel comparisons can be performed 
correctly. 

o Suitable logging rates  
o Suitable display filtering 
o Minimum and maximum range 
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Selecting Channels 
There are two methods of selecting channels, either the Category Method or 
the Search Method. 

Category Method 
This method divides all the channels into categories and sub categories, so 
that the list can be narrowed down to a small list of channels. For example, 
the ‘Engine Sensors / Cooling’ category shows a list of channels associated 
with the cooling system of the engine. 
When selecting a channel from the complete list of channels, it is usually 
easiest to use the category selection method, for example when assigning a 
channel to an input pin. 

To expand a category 
• click on the plus sign (+) next to the category name. 
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Search Method 
This method lists all channels in alphabetical order and allows a channel to be 
found either by typing the first few letters of any word in the channel name, or 
by scrolling through the list. 
Note: The words may be typed out of order so that ‘Engine Oil Temp’ could 
be found by typing "temp eng oil" or "oil t eng" or "e o t” 
This method is most useful when selecting a channel from the available 
channels.  

For example, if ‘Engine Temperature’ has been assigned to an input pin, it 
can be easily located in the Search list, since this list normally only 
contains 50 to 100 items. 
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Connections 

Configuring Inputs (optional) 
On the Connections menu, click Devices 
Select the device (e.g. CDL3) and then click the Input Pins tab 
This will list all inputs available for this product 
Select the input and click Channel (or double-click the input) 
Assign a measurement channel to the input and click OK 
The channel needs to be calibrated using one of two options: 
Select Load Cal if a pre-defined calibration is available 
OR 
Double-click the input to enter a calibration 
Other tasks: 
• Change Cal – to change the calibration 
• Spd Levels – only for speed inputs 
• Settings – to set default 

Configuring Outputs (optional) 
1. On the Connections menu, click Devices 
2. Select device (e.g. CDL3) and then click the Output Pins tab to list all 

outputs available for this product 
3. Select the output and click Change (or double-click the output) 
4. Select a mode to make appropriate settings available 
5. Follow the directions on the screen and when all settings are done 

click OK 

Configuring Communications 
1. On the Connections menu, click Communications 
2. Select an available communications section (CAN or RS232) 
3. Click Select and choose one of the available communications 

templates 

Comms templates 
Communication templates are available for most connected MoTeC devices. 
When MoTeC releases new products, new communication templates will also 
be released. These will be incorporated in the latest software versions. See 
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Dash Manager Software on how to update to a new software version to make 
the latest communication templates available. 

Calculations 
The Dash Logger has special and user definable general purpose calculations 
available. They are set up from the Calculations menu. 

Special Calculations 
• Lap Time and Number – click on the tabs to set up Lap Time, Lap 

Speed, Running Lap Time, Split Lap Times, Lap Number, Laps 
Remaining 

• Speed and Distance – click on the tabs to set up Ground Speed, Drive 
Speed, Wheel Slip, Lap Distance, Trip Distance, Odometer 

• Lap Gain/Loss – to set up a continuous indication of how far behind or 
ahead the vehicle is compared to a reference lap 

• Gear Detection – to set up Current Gear 
• Fuel Prediction – click on the tabs to set up Fuel Used, Fuel Usage, 

Fuel Remaining, Laps Remaining, Fuel Used per Lap 
• Speed Min/Max – to perform Min/Max Speed calculation (Peak/Trough 

detection) 

General Purpose Calculations 
• Tables – to set up 2D and 3D Lookup Tables 
• Timers – to set up General Purpose Timers 
• User Conditions – to activate items such as a Thermatic Fan or 

Gearbox Oil Pump 
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Functions 

Data Logging (optional) 
Data logging allows sensor readings and calculated values to be stored in the 
Dash Logger's memory for later analysis using the i2 Data Analysis software. 

To configure logging 
1. On the Functions menu, click Logging 
2. Select the relevant tabs to set up the logging parameters 

Power 
The Dash Logger power can be turned off at any time without losing the 
logged data, because it uses FLASH memory that does not require an internal 
battery to keep it alive. 

Logging Memory 
The CDL3 has optional Data Logging upgrades providing 8 MB of logging 
memory. See Dash Logger Upgrades. 

Start and Stop Logging Conditions 
To avoid logging unnecessary data, logging can be started and stopped by 
user definable conditions. 
For example logging might start when the vehicle exceeds 50 km/h, and stop 
when the engine RPM is below 500 rpm for 10 seconds. 
The Dash Logger provides the normal logging type; this will continuously log 
data to memory whenever the Start Condition is true and the Stop Condition is 
false. 

Memory Usage 
When the logging memory is full the Dash Logger may be configured to either 
stop logging, or to overwrite the oldest data, which ensures that the most 
recent data is always available. This is referred to as cyclic logging. 
For most applications it is recommended that cyclic logging is used. 

Logging Time 
The maximum logging time is dependent on the logging memory size, the 
number of items logged and the rate at which they are logged. The Dash 
Manager software will report the total available logging time. 



38 Configuration 

Logging Setup Files 
The logging list can be saved and loaded from a file. This allows multiple 
logging setups to be used. 

Logging Rate 
The logging rate sets how often each channel is logged and can be set 
individually for each channel.  
The rate at which the values are logged must be fast enough to record all 
variations in the reading. If the value is logged too slowly, the readings can be 
totally meaningless. For example, suspension position may need to be logged 
at 200 times per second or more. 
However, if a value is logged faster than necessary it will not improve the 
accuracy of the logged data. It will just reduce the total logging time available. 
For example, the engine temperature only needs to be logged at once per 
second. 

CAN Bus Bandwidth Limit 
High logging rates also increase the amount of data that is being received 
from the measurement devices, which increases the amount of data on the 
CAN bus. This can lead to exceeding the CAN bus bandwidth limit. See 
CAN Bus Bandwidth Limit 
Note: The Dash Manager software will warn if the bandwidth is likely to be 
exceeded. 

Maximum Logging Rate 
The maximum logging rate is limited to the update rate of the particular 
channel. This varies significantly depending on the source of the channel. 
For example, some communications devices may only update at 50 Hz. 
Also some internal calculations may be limited to 100 Hz. 

Update Rate 
Each input is measured at a maximum rate which is dependent on the 
capabilities of the measuring device and may also vary between inputs on that 
device. See Update Rate Summary 

Anti-Alias Filter 
If a channel is logged at a rate slower than its specified update rate then an 
optional anti-alias filter can be applied. 
The anti-alias filter is used to average out any variations in the signal between 
logged values. This ensures that unrepresentative values are not logged. 
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The anti-alias filter is implemented by averaging the channel values between 
logging events. For example, if a channel has an update rate of 1000 Hz and 
it is logged at 100 Hz then the preceding 10 samples will be averaged each 
time it is logged. 
The anti-alias filter is normally turned on by default when a channel is added 
to the logging list, but may be turned off if required. For normal purposes it is 
recommended that the anti-alias filter is left turned on. 
Note: For some channels the anti-alias filter cannot be turned on because the 
averaging performed by the filter would cause incorrect values. This is the 
case for on/off channels and channels where the bit values have a particular 
meaning, for example error group channels. 

Real Time Value (ADL2, SDL) 
For channels that come from an ADL2 or an SDL, the logging anti-alias 
filter also affects the real-time value of the channel. This is the value that 
all other parts of the system see, such as the various calculations. 
Note: The anti-alias filter is limited to 50 Hz for real time values even if the 
channel is logged at a lower rate. For example, a channel logged at 10 Hz 
will be filtered and updated at 10 Hz in the logging and 50 Hz for the real 
time value. 
Note: Channels that are not logged are updated at 50 Hz. 

Real Time Value (For devices other than ADL2, SDL) 
The real time value from other devices and from internal calculations is not 
anti-aliased at the logging rate, however the value can be anti-aliased in 
the logging. 

Phase Shift 
The anti-alias filter will cause a phase shift (time delay) of half the logging 
rate. For example, a channel logged at 100 Hz is logged every 10 
milliseconds, so it is delayed by 5 milliseconds. 
For most purposes this time delay is not an issue. 
Channels logged at the same rate are delayed by the same amount, which 
negates this effect when comparing these channels. 
This applies to all channels whether they are generated internally from a 
calculation or whether they are generated externally from devices such as 
a display device. 
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Track Map  
For the i2 Data Analysis software to plot a track map, either a GPS should be 
connected or a number of separate sensors that will provide the required 
information.  

Track Map using GPS 
Ensure GPS Latitude and GPS Longitude are logged.    

Track Map using Sensors 
The following sensors are required and must be logged: 
• Lateral G force (internal sensor) 
• Wheel Speed 
• Lap Beacon (the ‘Beacon’ Channel must be logged) 
• Optionally Longitudinal G force (internal sensor) 

A Longitudinal G force sensor should be used if the vehicle has only 
one wheel speed sensor. This allows the analysis software to eliminate 
wheel lockups which is essential when creating or using a track map. 
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Display 
The Dash Logger display is a high contrast, high temperature, custom made 
LCD display. 
The display contains a Bar Graph, three Numeric Displays, a Centre Numeric 
Display and a Bottom Alpha / Numeric Display. 

To configure the display 
• On the Functions menu, click Display 
• Select the relevant tabs to set up the display 

 

Display Modes 
The display has three main modes of operation; Race, Practice and Warm-up. 
The mode is changed by pressing a button that is wired to the system. 
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Race Mode 
 

 
The Race display is normally used to display minimal information, e.g. 
RPM, Lap Time, Fuel Remaining or Laps Remaining. 
The bottom alpha/numeric display can be used to display additional 
information as needed. 

Practice Mode 
 

 
The Practice display is used to display basic information, plus information 
to help the driver improve lap times, e.g. Lap Time, Lap Gain/Loss, 
Maximum Straight Speed, Minimum Corner Speed or Corner Exit Speed. 
The bottom alpha/numeric display may be used to display additional 
information as needed. 
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Warm-up Mode 
 

 
The Warm-up display is used to display important engine sensor readings 
during engine warm-up, e.g. RPM, Battery Voltage, Engine Temperature, 
Oil Pressure, Oil Temperature and Fuel Pressure. 
The bottom alpha/numeric display can be used to check many other warm-
up values. 

Bar Graph 

 
The 70 segment bar graph has a user definable range and is typically used as 
a tacho, however it can be used to display any other value. When used as a 
tacho it may be configured for up to 19000 RPM. 
A fully programmable shift point can be displayed, which can also be gear 
dependent. 
The operation of the bar graph can be different for each of the display modes 
(Race, Practice and Warm-up), this allows a lower range to be used in Warm-
up mode. 
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Numeric Displays 
 

 
The three numeric displays–left, right and top right–can be programmed to 
display any value, which may be different for each of the display modes 
(Warm-up, Practice and Race). 
Each of the three numeric displays has a different number of digits and is 
therefore suited to displaying different values. For example the top right 
display can only show values up to a maximum of 199 and is therefore not 
suitable for displaying Lap Times, but is suitable for values such as Lap 
Number, Fuel Remaining or Engine Temperature. 
The numeric displays can show any channel value plus up to two override 
values. Override values show each time their value is updated. This is useful 
for values that are updated periodically. The override values are shown for a 
programmable period of time. For example, a numeric display could normally 
show the Running Lap Time (which is continuously updating), then be 
overwritten by the Lap Time for 10 seconds each time the Lap Time is 
updated. 
Enunciators for common displayed values are provided above the numeric 
displays (e.g. ET for Engine Temperature, OP for Oil Pressure). 

Centre Numeric Display 
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The centre numeric display is normally used to display the current gear but 
can be used for other purposes. 

Bottom Alpha/Numeric Display 
 

 
The 13 digit bottom alpha/numeric display can display up to 20 lines of 
information that can be scrolled up or down using external buttons. Each of 
the 20 lines can display up to 3 channel values at a time. 
The values shown may be different for each of the three display modes. 
Similar to the numeric displays, the bottom alpha/numeric display can show 
up to four override values. 
The bottom alpha/numeric display will also show any active alarm messages, 
which will override all other values until the alarm is cleared. 

Display Formatting 

Units 
All display units can be changed to suit the driver preferences, for 
example, show temperatures in Fahrenheit rather than in Celsius. 
Note: This is independent of the units used for other purposes. 

Decimal Places 
The number of decimal places can be reduced for display purposes, for 
example the engine temperature is measured to 0.1 °C but is better 
displayed with no decimal places. This is normally done automatically. 

Alarms 
When an alarm is activated, a message is shown on the bottom line of the 
display. To draw the driver's attention to the display, it is recommended to 
activate a warning light. 
The message can be defined as required and can include the current sensor 
reading or the sensor reading when the alarm was triggered. 
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The alarms remain active until they are acknowledged, either by a driver 
activated switch or automatically after a defined period of time. 
The warning alarm limits are fully programmable and may include up to 6 
comparisons to ensure that the alarms are only activated at the correct time. 
For example, an engine temperature alarm may activate at 95 °C if the ground 
speed has been above 50 km/h for 30 seconds. The speed comparison 
avoids the alarm showing during a pit stop due to heat soak. Additionally 
another comparison could be set at a higher temperature to cover all other 
situations. 
The comparison values can be automatically incremented or (decremented) 
when an alarm occurs. For example the engine temperature alarm may be set 
at 95 °C with and increment of 5 °C, so the second time the alarm activates at 
100 °C. A limit may be set on the number of times the comparison value is 
allowed to increment. An alarm may return to its original value after a period 
of time, in case the alarm condition was temporary. 
The alarms can be dependent on the current display mode (Warm-up, 
Practice or Race). 

Other Functions 
The Dash logger can perform many other functions accessible from the 
Functions menu including the following: 
Shift Lights – to control up to four staged shift lights 
Shift Light Module – to configure MoTeC's SLM-C or SLM 
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Operation 
When operating the CDL3, any of the activities of the Online menu of the 
Dash Logger Manager software can be performed. This requires the PC to 
communicate to the Dash Logger.  
Note: All other menu items perform offline activities. 

Retrieving the Logged Data 
• On the Online menu, click Get Logged Data 

A PC is used to unload the logged data from the Dash Logger. The logged 
data is then stored on the computer's hard disk. 
After each unload the user has the option to clear the logging memory. 
The unload may be interrupted part way through if necessary by 
disconnecting the computer. The partial unload will contain the most recently 
logged data and will be stored on the computer's hard disk. In this case the 
Dash Logger memory is not cleared and logging will continue as normal at the 
end of the existing data. Next time the logged data is unloaded both the new 
data and the previously partly unloaded data will be retrieved. 

Sending and Retrieving Configuration Files 
• On the Online menu, click Send Configuration to send the currently 

open configuration file 
Note: When a configuration file is sent to the Dash Logger the existing 
data is retrieved and stored in the From Dash Backups directory to use 
in case the data in the Dash Logger needs to be restored. The 
maximum number of files is 10. 

• On the Online menu, click Get Configuration to retrieve the current 
configuration file. 
This will only be necessary if the original file is not available on the PC. 

Zeroing Sensors 
Some sensors require regular zeroing, for example Steering Angle, 
Suspension Position, Ride Heights, G Force Sensors and Throttle Position. 
Dash Manager software provides a feature for easy zeroing of all these 
sensors. 
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Checking Operation 
Monitor Channels 
The currently active channels can be monitored to check the operation of all 
functions and measurements. 

• On the Online menu, click Monitor Channels 
• To show any channel on an oscilloscope style screen, click Utilities 

and then Oscilloscope 

Simulate 
The Simulate feature allows most input channels to be manually changed so 
that the Dash Logger operation can be checked under abnormal conditions, 
e.g. High Engine Temp. This is extremely useful for checking that the Dash 
Logger is working as expected. 

• On the Online menu, click Simulate 

Test 
A number of tests are provided to check the operation of the Dash Logger, 
such as the Display test. 

• On the Online menu click the appropriate test 

Configuration Versions and Updating  
• On the Online menu, click Upgrade Dash Version 

The software inside the Dash Logger (firmware) can be updated by the user 
at any time to take advantage of the latest features. 

Matching Versions 
The firmware version must match the version of the Dash Manager software 
on the PC in order to communicate. Dash Manager will show a warning if the 
versions do not match. 
Tip: 
To check the version of Dash Manager, click About MoTeC CDL3 Dash 
Manager on the Help menu. 
The firmware version is displayed on the bottom line of the display for two 
seconds when the Dash Logger is powered. 

Matching Configuration File 
The configuration file must also match the software and firmware versions 
used. The display will show a warning if the file does not match. 
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Configuration files can be updated by choosing the option to automatically 
update the configuration file while updating the software (firmware). It can 
also be done manually by upgrading the configuration file and sending it to 
the Dash Logger: 
• On the File menu, click Open 
• In the Files of type box select the new version file extension. 

The file will be converted to the new version format and saved with the 
same file name but with the new version file extension. 
Note: The old file is not changed. 

• On the Online menu, click Send Configuration to send the 
configuration file to the Dash Logger 

Upgrading the Dash Logger 
Several options are available as upgrades to customise and grow your 
system. 
The currently enabled options can be listed and new options can be activated 
through a password acquired from MoTeC.     

To Upgrade the Dash Logger 
• On the Online menu, click Enable Dash Options 

Password Protection 
• On the Online menu, click Set Access Passwords 

Several Dash Logger capabilities can be protected from unauthorised access 
by using the password protection. 
Note: Ensure you keep passwords secure. The unit needs to be returned to 
MoTeC for unlocking if the passwords are lost.   

Other Online Activities 
Many other activities are accessible from the Online menu including the 
following: 
Reference Lap – to send a reference lap to the Dash Logger used in the 
lap gain/loss system. 
View – to view: 

o saved details e.g. Running Totals 
o Device Halt Counts 

Communication – to list the current Connections Settings 
Miscellaneous 
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o Erase Logged Data without unloading 
o Serial Number to view the Serial and Hardware Number; 

the Serial Number is required when ordering upgrade passwords, the 
Hardware Number is for MoTeC internal use 

o Change Display Mode to switch between Practice, Warm-up and 
Race mode 
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Appendices 

Specifications 
Specifications listed as optional are available as upgrades to customise and 
grow your system. These additional features are activated through a simple 
password system, at any time when you need it. 
An overview of the upgrades can be found in Dash Logger Upgrades. 

Logging 
Optional 8 MB logging memory  
Logging rates up to 500 samples per second  
Fast Ethernet download 

Display 
70 segment bar graph 
13 digit alphanumeric text bar 
48 user-defined, scrollable message lines with programmable overrides 
3 programmable 'pages' for Practice, Warm-Up and Race 

Inputs - Optional 
4 x Analogue voltage inputs, some are high resolution inputs 
2 x Analogue temperature inputs 
2 x Digital inputs 
3 x Speed inputs with voltage measuring capability 
Compatible with up to two E888 expanders (8 Thermocouples only) 

Outputs - Optional 
4 x PWM, digital or switched outputs 

Internal Sensors 
3-axis accelerometer, detection range: +/- 5G
Dash temperature sensor 
Sensor supply voltage 
Battery voltage 
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Communications 
2 x CAN with individually programmable CAN bus speeds 

o Maximum data range 1 Mbit/sec 
o Recommended terminating impedance 100 ohm 
o Configurable as either CAN or RS232  

1 x RS232 

Physical 
Dimensions 180 x 91 x 18 mm excluding connector 
Weight 385 g 
1 x 34 pin AMP connector 

Power Supply 
Operating voltage: 8 to 32 volt DC 
Operating current: 0.15 ampere typical (excluding sensor currents) 
Reverse Battery protection 
Battery Transient protection   

Operating Temperature 
Internal Temperature Range -10 to 80 °C 
Ambient Temperature Range -10 to 70 °C 

Sensor Supply Current 
5 V Sensor supply: 0.2 ampere maximum 
8 V Sensor supply: 0.3 ampere maximum 
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Dash Logger Upgrades 
For the CDL3 Dash Logger the following upgrades are available: 

Data Logging 8 MB 
Allows recording of all input data to a 8 MB internal logging memory.  
 

12 I/O upgrade 
Allows use and configuration of 12 extra inputs and outputs.  
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Characteristics 

Input Characteristics 

Analogue Voltage Inputs 
Suitable for Potentiometers  

Voltage output sensors  
Variable resistance sensors with pull-up 
resistor 

Measure Voltage Range Inputs: 0 to 5.46 V  
Note: Voltages outside this range may affect 
the readings on other inputs. 

Input Resistance 100k ohms to 0 V 

Resolution Inputs: 1.33 mV  
 

Measurement Methods Ratiometric  
Absolute 
Variable Resistance Off/On 

Update Rate 1000 times/second 

Filter 240 Hz 1st order 

Calibration Accuracy Gain 0.05% max (Ratiometric method)  
Gain 0.15% max  (Absolute method) 
Offset � 6 mV max 
Linearity � 6 mV max 
Temperature Stability 60 ppm/°C max 
Calibration Schedule 12 months 
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Analogue Temp Inputs 
Suitable for 2 wire variable resistance sensors and some 

voltage output sensors 

Measure Voltage Range 0 to 15.0 V  
Note: Voltages outside this range may affect 
the readings on other inputs. 

Input Resistance 1000 ohms pull-up to 5 V sensor supply  
+100 k to 0 V 

Resolution 3.66 mV 

Measurement Methods Ratiometric  
Absolute 
Variable Resistance 
Off/On 

Update Rate 1000 times / second 

Filter 290 Hz 1st order 

Calibration Accuracy  
  

Gain: 0.05% max (Ratiometric method) Gain: 
0.15% max (Absolute method)  
Offset: ± 6 mV max 
Linearity: ± 6 mV max 
Temperature Stability: 60 ppm/°C max 
Calibration Schedule: 12 months 
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Digital Inputs 
Suitable for Switch to 0 V  

Logic signal and open collector device (e.g. Hall 
Switch) 

Pull-up Resistor 2200 ohms to 3.3 V 

Voltage Range 0 to 15 V 

Positive Trigger 
Threshold 2.4 V max 

Negative Threshold 0.6 V min 

Hysteresis 0.4 V min 

Update Rate 100 times / second 

Filter Time Constant 22 usec 

Measurement Methods  Frequency  
Resolution 0.1 Hz 
Maximum Frequency 3200 Hz 
Rising Edge Triggered 
 
Period 1 usec 
Measures period between rising edges 
Resolution 1 usec 
Maximum 32 msec 
 
Period 100 usec 
Measures period between rising edges 
Resolution 100 usec 
Maximum 3.2 sec 
 
Pulse Width 1 usec 
Measures pulse low time 
Resolution 1 usec 
Maximum 32 msec 
 
Pulse Width 100 usec 
Measures pulse low time 
Resolution 100 usec 
Maximum 3.2 sec 
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Speed Inputs 
Hall mode A 2200 ohm pull-up resistor is connected to 2.7 V 

Suitable for Switch to 0 V  
Logic signal 
Open collector device (e.g. Hall Switch) 

Pull-up Resistor 2200 ohms to 2.7 V 

Voltage Range 0 to 15 V 

Trigger Threshold Selectable between -1.33 V and 4.68 V 

  

Magnetic mode  
  

The pull-up resistor is disengaged and the trigger 
levels can be varied depending on the input 
frequency 

Suitable for Two wire magnetic sensor (variable reluctance 
sensor) 

Input Resistance 100k ohms to ground (no pull-up) 

Voltage Range -80 V to +80 V 

Programmable 
Trigger Levels 

-1.33 V to 4.68 V 

    

For both modes   

Update Rate 100 times / second 

Filter Time Constant 25 usec 

Hysteresis 0.17 V min 

Measurement 
Methods 

Frequency  
Resolution 0.1 Hz 
Maximum Frequency 3200 Hz 
Falling Edge Triggered 
 
Period 1 usec 
Measures period between falling edges 
Resolution 1 usec 
Maximum 32 msec 
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Period 100 usec 
Measures period between falling edges 
Resolution 100 usec 
Maximum 3.2 sec 
 
Pulse Width 1 usec 
Measures pulse high time 
Resolution 1 usec 
Maximum 32 msec 
 
Pulse Width 100 usec 
Measures pulse high time 
Resolution 100 usec 
Maximum 3.2 sec 
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Analogue Input Sampling 
4 times oversampling is scheduled with samples taken every 250 usec, 
providing measurements every 1 msec. 
The following inputs are sampled at 250 usec, with microsecond offsets as 
shown in the table: 

Offsets 0.0 usec +1.5 usec

 0.0 usec AT1 AV1 

+9.3 usec AT2 AV2 

+20.9 usec N/A AV3 

+30.1 usec N/A AV4 

+39.4 usec N/A N/A 

+51.0 usec N/A N/A 

+60.3 usec N/A N/A 

+71.9 usec N/A N/A 

+81.1 usec N/A INTTEMP

+90.4 usec 8VSEN SPD1 

+102.0 usec 5VSEN SPD2 

+111.3 usec GLAT SPD3 

+122.9 usec GVERT N/A 

+132.1 usec GLONG N/A 

+141.4 usec N/A BAT+ 

Output Characteristics 
 

Output Type Open Collector (drives to ground) with weak pull-up (10 
kΩ) to battery positive 

Current 0.5 A max, current limited and thermal overload protected 

Output Clamp 50 V Flyback Clamp (no clamp diode to supply) 

  



60 Appendices 

CDL3 Pin List by Pin Number 
Pin  Name  Function 

1  E-TX-     Ethernet Transmit -                      

2  E-TX+     Ethernet Transmit +                        

3  AV1     Analogue Voltage Input 1               

4  AV2     Analogue Voltage Input 2               

5  AV3     Analogue Voltage Input 3               

6  AV4     Analogue Voltage Input 4               

7  8V  Sensor 8 V                            

8  5V  Sensor 5 V                            

9  0V  Sensor 0 V Analogue Volt & Analogue Temp  

10  E-RX-     Ethernet Receive -                        

11  E-RX+     Ethernet Receive +                        

12     

13     

14  DIG1      Digital Input 1                      

15  DIG2      Digital Input 2                      

16  AT1     Analogue Temp Input 1                  

17  AT2     Analogue Temp Input 2                  

18  CAN1L     CAN1 Lo                              

19  CAN1H     CAN1 Hi                              

20  TX     RS232 Output                         

21  SPD1      Speed Input 1                        

22  SPD2      Speed Input 2                        

23  SPD3  Speed Input 3 

24     
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25     

26  CAN2L     CAN2 Lo                              

27  CAN2H     CAN2 Hi                              

28  RX  RS232 Input                          

29  AUX1     Auxiliary Output 1                   

30  AUX2     Auxiliary Output 2                   

31  AUX3     Auxiliary Output 3                   

32  AUX4  Auxiliary Output 4   

33  BAT+      Battery Positive                     

34  BAT-      Battery Negative                     
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CDL3 Pin List by Function 
Pin Name Function 

Battery Power 

34 BAT- Battery Negative 

33 BAT+ Battery Positive 

Analogue Voltage Inputs 

3 AV1 Analogue Voltage Input 1 

4 AV2 Analogue Voltage Input 2 

5 AV3 Analogue Voltage Input 3 

6 AV4 Analogue Voltage Input 4 

Analogue Temp Inputs 

16 AT1 Analogue Temp Input 1 

17 AT2 Analogue Temp Input 2 

Digital Inputs 

14 DIG1 Digital Input 1 

15 DIG2 Digital Input 2 

Speed Inputs 

21 SPD1 Speed Input 1 

22 SPD2 Speed Input 2 

23 SPD3 Speed Input 3 

   

Auxiliary Outputs 

5 AUX1 Auxiliary Output 1 

6 AUX2 Auxiliary Output 2 

7 AUX3 Auxiliary Output 3 

8 AUX4 Auxiliary Output 4 
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Pin Name Function 
8 V Sensor 

7 8V Sensor 8 V 

5 V Sensor 

8 5V Sensor 5 V 

0 V Sensor 

9 0V Sensor 0 V 

CAN Interface 

19 CAN0H RS232 / CAN 0 High 

18 CAN0L RS232 / CAN 0 Low 

27 CAN1H RS232 / CAN 1 High 

26 CAN1L RS232 / CAN 1 Low 

Ethernet 

10 E-RX- Ethernet Receive - 

11 E-RX+ Ethernet Receive + 

1 E-TX- Ethernet Transmit - 

2 E-TX+ Ethernet Transmit + 

RS232 

28 RX RS232 Input 

20 TX RS232 Output 
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Mounting Dimensions 
CDL3 

 
 
Note: 
• All dimensions in [mm] 
• Ensure product is not stressed when mounted 
• Dimensions indicate actual product size, allow for clearance when 

mounting  
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Wiring 
This section provides reference material about the Dash Logger's connector 
and wiring requirements.   

Connector 
CDL3 connector 34 pin connector 

Mating connector 34 pin AMP connector #65044

Wire Specification 

Wire 
Wire to suit Dash Logger connector: 22# Tefzel, Mil Spec : M22759/16-22 

M22759/16 Wire Ratings (for various wire gauges) 
Insulation Material: Tefzel 
Conductor: Tin Plated Copper 
Voltage Rating: 600 V 
Maximum Temperature: 150 °C 

  

Wire Gauge 
[AWG] 

Cross 
Sectional Area 
[mm2] 

Max Current 
at 100 °C 
Ambient [A] 

Resistance
[ohm/m] 

Resistance 
[ohm / 1000 ft] 

22 0.38 5 0.045 14.0 

20 0.61 6 0.028 8.5 

18 0.96 9 0.018 5.5 

16 1.2 12 0.014 4.3 

14 1.9 18 0.009 2.7 

12 3.0 24 0.006 1.8 

Wire Stripping Tool 
Recommended: Ideal Industries 45-2133 stripping tool with LB1195 wire stop 
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PC Connection 

Ethernet Wiring Schematic: 

CDL3 Ethernet Connector 

Pin Function Pin Function 

11 Ethernet RX+ 1 Ethernet TX+ 

10 Ethernet RX–  2 Ethernet TX– 

2 Ethernet TX+ 3 Ethernet RX+ 

1 Ethernet TX–  6 Ethernet RX– 

Pin numbering 

 
Plug                     Socket 

Wire 
CAT5 UTP Ethernet cable 

Cable 
An Ethernet RJ45 socket, connecting to a standard Ethernet cable, is 
provided on: 

• #62202 CDL3 loom 
• #61131 Ethernet cable, unterminated, 2 metre 
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CAN Bus Wiring Requirements 
• The CAN bus should consist of a twisted pair trunk with 100R (0.25 watt) 

terminating resistors at each end. 
o If the CAN bus is less than 2 metres (7 ft) long, a single termination 

resistor may be used. 
• The preferred cable for the trunk is 100R data cable. 
• The maximum length of the bus is 16 metres (50 ft) 
• CAN devices (such as MoTeC Dash Loggers, ECUs etc.) may be 

connected to the trunk with up to 500 mm (20 in) of twisted wire. 
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CDL3 Dash Logger to ECU wiring (RS232) 
The following details the methods for connecting the Data Logger to various 
MoTeC ECUs via RS232. In all cases this is done using the serial data stream 
generated by the Telemetry function of each ECU. 
In the case of the M800, M880 and M4e the Data Logger may be directly 
wired to the ECU because these ECUs use RS232 interface levels. On the 
M48, M4 (pre M4e) and the M8, a Computer Interface Module (CIM) or a PCI 
cable is required to convert the signals to RS232. 

M4e 

 
Note: 
• Older M4 ECUs require a different connection method 
• The data to the Dash Logger will be interrupted while a PC is connected. 

M48, M4 (pre M4e) and M8 
The M48, M8 and M4 (pre M4e) require the use of a CIM module or a PCI 
Cable to convert the logic level signals used by these ECUs into RS232 
levels. 
Using a CIM Module 

 
  
Contact MoTeC for the CIM module drawing for full wiring details. 
Note: 
• The data stream to the Dash Logger will be interrupted while a PC is 

connected. 
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Update Rate Summary 

Device Input Type Maximum Update 
Rate (per second) 

ADL3 Analogue Voltage Inputs 1000 

ADL3 Analogue Temperature Inputs 1000 

ADL3 Digital Inputs and Speed Inputs 100 

ADL3 RS232 and CAN Communications 50 max * 

ADL3 CAN comms fast receive 1000 

ACL RS232 Communications 200 * 

ACL General CAN communications 200 * 

CDL3 Analogue Voltage Inputs 500 

CDL3 Analogue Temperature Inputs 500 

CDL3 Digital Inputs and Speed Inputs 100 

CDL3 RS232 and CAN Communications 50 max * 

CDL3 CAN comms fast receive 500 

VIM AV Fast Inputs 5000 

VIM AV Differential Voltage Inputs 1000 

VIM AV High Resolution Inputs 500 

VIM AV Special Inputs 2000 

VIM Speed Inputs 100 

ADL2/SDL Analogue Voltage Inputs 1 to 4 
(ADL2/SDL) and 11 to 14 (ADL2) 1000 

ADL2/SDL Other Analogue Voltage Inputs 500 

ADL2/SDL Analogue Temperature Inputs 500 

ADL2/SDL Lambda Inputs 100 

ADL2/SDL Digital & Speed Inputs 100 

SDL Internal G Sensors 100 

E888 Thermocouple Inputs 
(First Device / Second Device) 100 / 50 

E888/816 Analogue Voltage & Digital Inputs 
(First Device / Second Device) 200 / 50 
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* RS232 and general CAN communications update rate depends on how 
frequently the data is sent from the device. Typically the update rate from an 
M4, M48, M8 or M800 ECU is about 20 times per second using RS232 and 
about 50 times per second for the M800 and M84 using CAN. 
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Command Line 
Usage: 
Clubdash3.exe -c[connection] -d -x -l -e -t -s [config file name] 
  
[config file name] 
(Optional) 
Fully qualified path to the configuration file. 
(eg "c:\motec\dash\config\bathurst.d30") 
Note: the path must included the file extension (e.g. .d30) 

Options : 
Each of the following options can be given as "/[character]" or "-
[character]".   They are shown here as "-[character]". 
  
-c[Connection Name] 
(Optional) 
Select a preconfigured connection by name as configured in the dash 
connections dialog. 
(e.g. -c"Primary CAN Connection"). 
Note: There must not be a space between the c and the connection name. 
  
-d 
(Optional) 
Causes the debug console to be displayed. 
Only available for debug builds. 
  
-x 
(Optional) 
Causes the app to terminate when one the following tasks has been 
performed. 
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Tasks : 
One or more of the following may be specified. 
  
-l 
(Optional) 
Perform a “Get Logged Data” operation. 
  
-e 
(Optional) 
Perform a “Get Engine Log” operation. 
  
-t 
(Optional) 
Perform a “Get Tell-tale Values” operation. 
  
-p 
(Optional) 
Perform a “Print Summary” operation. 
Note: The configuration file must be specified using a fully qualified path 
including the file extension. 
(e.g. -p "c:\motec\dash\config\bathurst.d30") 
Note: There must be a space between -p and configuration file name. 
  
-s 
(Optional) 
Perform a “Send Configuration” operation. 
Note: The configuration file must be specified using a fully qualified path 
including the file extension. 
(e.g. -s "c:\motec\dash\config\bathurst.d30") 
Note: There must be a space between -s and configuration file name. 
  
-u 
(Optional) 
Perform an “Upgrade Dash Version” operation. 
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CAN Bus Bandwidth Limit 
The total available CAN bandwidth on a single CAN bus is 1 Mbit/sec. 
The bandwidth used by the total of all devices on a particular CAN bus must 
not exceed approximately 90% of this value (900000 bits/second) 
If the total bandwidth required exceeds this specification then some devices 
should be connected to the second CAN bus. 
Note: Dash Manager will warn if the bandwidth is likely to be exceeded. 

E888 
Device on first CAN Address: Bandwidth = 145000 (bits/sec) 
Device on second CAN Address: Bandwidth = 55000 (bits/sec) 

Other Devices 

Device Bandwidth

BR2, SLM, PLM Negligible 
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Comms Error Codes 
The "Comms CAN x Diagnostic" and "Comms RS232 Diagnostic" channels 
can be used to diagnose communications problems. 
Multiple errors are shown by error codes added together. For example: 
A RS232 error of 9 = parity + overrun. 
The error values have the following definitions: 

RS232 Errors 
Errors generated by RS232 communications. 

1 PARITY Parity bit incorrect. The comms parity setup is 
wrong, or there is electrical interference causing 
errors in the data. 

2  FRAMING Not seeing the stop bit. The baud rate or stop 
bit setup is wrong or there is electrical 
interference causing errors in the data. 

4  NOISE Glitch in the data. Electrical interference is 
causing glitches in the signal. (the Dash Logger 
does not generate this error) 

8  OVERRUN A byte was received before the previous byte 
was read indicating that the processor was too 
busy to read the message. 

512  NO DATA A valid message header was not found - either 
there is a wiring fault or comms is setup 
incorrectly. 

1024  CHECKSUM A valid message header was found, but the 
checksum was wrong. If seen in combination 
with other errors there is electrical noise. If only 
checksum errors occur there may be a 
software incompatibility between the Dash 
Logger and the other device. 

2048 WRONG DATA Could not decode the protocol. 
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General CAN Errors 
Errors generated by general CAN communications. 

2 FRAMING Only generated when used with an 
E888/E816 expander. Inconsistent message 
length. 

8   OVERRUN Receive or transmit overrun error. In the 
receive case a byte was received before the 
previous byte was read indicating that the 
processor is too busy to read the message. 
In the transmit case the transmit buffer is full 
which could happen if the CAN bus is too 
busy. 

256   BAD CONFIG The device configuration is not valid (e.g. 
overlapping CAN addresses) 

512   NO DATA A valid message header was not found - 
either there is a wiring fault or comms is 
setup incorrectly, (problem could be at either 
end), e.g. transmit and receive CAN IDs do 
not match. 

1024   CHECKSUM Only generated when used with an Async 
Expander. See RS232 errors 

2048   WRONG DATA Only generated when used with an Async 
Expander or E888/E816 Expander. Async 
Expander: Could not decode the protocol. 
E888/E816: Compound ID incorrect. 

4096   BUS WARNING More than 96 errors have occurred on the 
CAN bus. Check wiring and termination 
resistors. The CAN bus may still be 
operational. 

8192   BUS OFF More than 255 errors have occurred on the 
CAN bus. CAN communications is 
suspended when this error occurs. Check 
wiring, termination resistors and the CAN 
baud rate. Also check that CAN HI and CAN 
LO are correct (not swapped). 

16384 CAN TRANSMIT CAN bus transmit warning 

"VIMCOM" Errors 
Errors generated by "VIMCOM" devices (SVIM, Dash Loggers). 
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Note: VIMCOM devices are connected via CAN. 

Dash Logger Errors (CDL3) 
These errors are generated by the Dash Logger's communications system. 

2 FRAMING Incorrect number of samples received. 

256   BAD CONFIG Configuration mismatch between Dash 
Logger and device. Resend the 
configuration. 

512   NO DATA VIMCOM packets have not been found. 
Either there is a wiring fault or Dash 
Logger Connections is setup incorrectly. 

2048   WRONG DATA VIMCOM packet has bad length. 

4096   BUS WARNING More than 96 errors have occurred on 
the CAN bus. Check wiring and 
termination resistors. The CAN bus may 
still be operational. 

8192 BUS OFF More than 255 errors have occurred on 
the CAN bus. CAN communications is 
suspended when this error occurs. Check 
wiring, termination resistors and the CAN 
baud rate. Also check that CAN HI and 
CAN LO are correct (not swapped). 

VIMCOM Device Errors. 
These error codes are sent once by the VIMCOM device on resuming data 
transmission and therefore indicate why data was previously not being 
transmitted. 

4097 STARTUP Device has restarted (normally due to 
power up). Data is not sent until sync is 
achieved. 

4098 HALT Data not sent due to deliberate halt. For 
example configuration or firmware being 
sent. 

4099 OVERRUN Data not sent due to transmit buffer 
overrun (possibly due to CAN bus too 
busy) 

4100   SYNC TIMEOUT Data not sent due to Dash Logger sync 
message timeout (sync not received 
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from Dash Logger) 

4101   CAN ERROR Data not sent due to error on CAN bus 

4102 SYNC 
EXCEEDED 

Data not sent due to excessive sync error 
(synchronisation too far out) 

Windows Keyboard Shortcuts 
When using a laptop in and around a car, it is often not practical to use a 
mouse to navigate through the program. 
Using the keyboard to select options is easier. 

Main Menu 

 
To access the main menu, press ALT + the key for the underlined letter in the 
menu, followed by the underlined letter of the item in the drop down menu, 
e.g. ALT + F, N for File New. 
Alternatively press and release ALT, select the desired menu item using the 
arrow keys, press ENTER to activate it. 

Closing a Window 
Press ENTER for OK or Close (only when the OK or Close button has a bold 
line around it) 
Press ESC to Cancel or Close 

Getting Help 
 Press F1 to get help on the current window or item 
Select Help from the Main Menu to access the main help system. 
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Selecting an Item in a Window 

 
To access the various items in a window, press ALT + the key for the 
underlined letter of the item of interest, e.g. to select the ‘Flash Light’ item 
press ALT + F 
Alternatively use the TAB key to move through the dialog box (use SHIFT + 
TAB to move backwards). The selected control is usually indicated by a 
dotted line around it, or by highlighting the text or item selected within the 
control. 

Using the Selected Item 
The method of using the selected item (or control) depends on the type of 
control. The common controls are detailed below: 

Command Button 

 
Command buttons are generally used to show another screen or perform a 
particular function. 

Press ALT + the key for the underlined letter (S), or use the TAB key to 
navigate to the command button. To select, press ENTER or SPACEBAR. 
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Check Box 

 
A check box is used to tick on or off a particular option. 
Press ALT + the key for the underlined letter (F), or use the TAB key to 
navigate to the Check Box.  To select, press SPACEBAR. 

Group Box 

 
The Group box is used to select an item from a group of options. 
Press ALT + the key for the underlined letter (F, A or D), or use the TAB 
key to navigate to the Group box. To select, use the arrow keys. 

Text Box 

 
A text box is used to enter a value or text. 
Press ALT + the key for the underlined letter (M) or use the TAB key to 
navigate to the Text box, type in the new value or text. Use BACKSPACE 
or DELETE to remove unwanted characters. 
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List Box 

 
A list is used to select from a number of options. 
Press ALT + the key for the underlined letter (M) or use the TAB key to 
navigate to the List Box. To select, use the arrow keys. 

Drop-down List Box 

 
A Drop-down list box is used to select from a number of items, but only the 
selected item is shown until a new item needs to be selected. 
Press ALT + the key for the underlined letter (L) or use the TAB key to 
navigate to the Drop down List Box. To select the desired item, use the 
arrow keys, and press ENTER to close the list. 

Tabs 

 
Tabs are used to select the different tab pages of a screen. 
To select the next tab, press CTRL + TAB. To select the previous tab, 
press CTRL + SHIFT +TAB. 
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Tree Structure 

 
A Tree Structure is used to select items from a hierarchical list 
The UP ARROW key moves the cursor up (selects the item above) 
The DOWN ARROW key moves the cursor down (selects the item below) 
The RIGHT ARROW key expands; expandable branches indicated by a 
plus sign (+) 
The LEFT ARROW key collapses; collapsible branches indicated by a 
minus sign (-) 
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Glossary 
MoTeC Devices 

ACL  Advanced Central Logger 

ADL2 Advanced Dash Logger - second generation 

ADL3 Advanced Dash Logger - third generation 

BR2 Beacon Receiver 

BTX Beacon Transmitter 

CIM Computer Interface Module 

CLS Central Logging System 

CDL3 Club Dash Logger  

DBW4 Drive By Wire expander 

E816 Input/Output Expander 

E888 Input/Output Expander 

i2 MoTeC data analysis software 

i2 Pro MoTeC data analysis software, professional version 

IEX Ignition Expander 

LTC Lambda to CAN module 

LTCD Lambda to CAN Dual module 

M2R ECU dedicated to run 2 rotor engines 

M4 ECU for engines with up to 4 cylinders or up to 2 rotors 

M400 ECU for modern engines with up to 4 cylinders or up to 2 rotors 

M48 ECU for engines with up to 8 cylinders and 2 rotors 

M600 ECU for modern engines with up to 6 cylinders or up to 3 rotors 

M800 ECU for modern engines with up to 12 cylinders or up to 4 rotors 

M800  
Plug-In ECU for direct replacement of a factory ECU 

M880 ECU for modern engines with up to 12 cylinders or up to 4 rotors 

MDC Mitsubishi Diff Controller 

MDD Mini Digital Display 

MLS ECU dedicated to run Chevrolet LS1 and Lexus/Toyota V8s 
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PCI Cable PC Interface cable 

PDM15 Power Distribution Module with 15 outputs 

PDM16 Power Distribution Module with 16 outputs 

PDM30 Power Distribution Module with 30 outputs 

PDM32 Power Distribution Module with 32 outputs 

PLM Professional Lambda Meter 

RTC Real Time Clock 

SDC Subaru Diff Controller 

SDL Sport Dash Logger 

SDL3 Sport Dash Logger – second generation 

SGA Strain Gauge Amplifier 

SLM Shift Light Module 

SLM-C Shift Light Module – Club version 

SUU Software Update Unit 

TCM Traction Control Module 

VIM Versatile Input Module 

Other 

Calibration The process of converting an electrical value into a physical 
value, e.g. volts into kilometres per hour 

CAN Controller Area Network - communication protocol 

CDI Capacitive Discharge Ignition 

ECU Engine Control Unit 

GPS Global Position System 

MAF Mass Air Flow 

MAP Manifold Absolute Pressure 

PID Proportional, Integral and Derivative gain 

PWM Pulse Width Modulated 

RPM Revolutions Per Minute 

RS232 Recommended Standard 232, communication protocol 

RX Receive 

TDC Top Dead Centre 
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TX Transmit 
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